
User Guide

2501 Skyblue Court
St. Paul, MN 55110

(651) 779 – 0955
http://www.qdea.com

sales@qdea.com
support@qdea.com

Synchronize! and Qdea are trademarks of Qdea.
Macintosh and the Mac OS logo are trademarks of Apple Computer, Inc.



Copyright Notice

Copyright © 2008 Qdea. All rights reserved.

Manual version 6.0
Ninth edition.

Warranty

Qdea warrants that any original purchased disk on which this software is
received is free from defects in material and workmanship, under normal use, for
90 days after the date of original purchase. If a defect occurs during the 90-day
period, you may return the disk to Qdea for a free replacement.

The remedy for breach of this warranty shall be limited to replacement and shall
not encompass any other damages, including but not limited to loss of profit, and
special, incidental, or other claims. The software is licensed and delivered on an
“as is” basis. Except for the express warranty set forth above, Qdea makes no
other warranties, either express or implied, by statute or otherwise, regarding the
enclosed computer software product, or its fitness for any particular purpose.

Software License

Each copy of Synchronize! Pro X is licensed for installation on one and only
computer. The software license may be transferred from one computer to another
by first uninstalling from one computer, then installing on another computer.

Installing Synchronize! Pro X on more than one computer requires the purchase
of one copy of Synchronize! Pro X for each computer.



Table of Contents
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Synchronization vs. Backup..............................................1
Copy files over the Internet...............................................1
File Synchronization.........................................................1
File Server Backup and Mirroring......................................1
Selective Backup .............................................................2
Keep Old Files.................................................................2
File Distribution................................................................2
Using Synchronize! Pro X with disks on the desktop...........2
Synchronizing remotely with removable disks ....................3

Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Installation ....................................................................................4

Try an example................................................................4
Using Synchronize! Pro X. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

The problem....................................................................5
The solution.....................................................................5
Using Synchronize! Pro X with removable disks.................5
Putting Synchronize! Pro X to work ...................................6
Using Synchronize! Pro X with a direct connection.............7
How Synchronize! Pro X works.........................................7
Advanced Features..........................................................8

Making a bootable OS X Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Make sure your Mac knows what time it is.......................................10
Erase the backup disk....................................................................10
Open Synchronize! Pro X...............................................................11
Setting up the backup ....................................................................11
Starting up from a bootable backup ................................................12

Six Ways To Use Synchronize! Pro X. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Tips and Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Using Synchronize! Pro X automatically ............................15
Starting syncs with AppleScript.........................................15
Keeping old files in an archive ..........................................16
Synchronizing with removable disks..................................17

Synchronize! Pro X Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Synchronize! Pro X Windows .........................................................18

Document Windows.........................................................18
Status Window ................................................................24
Waiting List Window.........................................................25
Auto Syncs Window.........................................................26
Log Window ....................................................................27

Synchronize! Pro X Menus.............................................................28
Synchronize! Pro X Menu.................................................28
File Menu........................................................................40
Edit Menu........................................................................41
Options Menu..................................................................41
Windows menu................................................................80



Table of Contents (continued)

Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Feedback. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Upgrades. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83



Introduction 1

Introduction

Synchronize! Pro X is an enhanced version of Synchronize! X Plus. In addition to
the many features in Synchronize! X Plus, Qdea’s personal file synchronization
software, it supports a number of advanced functions, including resolving aliases
and more flexible ways to include or exclude files and folders.

Synchronization vs. Backup

A “Synchronization” compares two files and copies the newer file to replace the
older file, while a “Backup” always copies files in one direction. In general, it’s
best to use a “Backup” if you want to make the destination look like the source,
because there’s less room for error and a “Backup” takes less computer
resources.

Synchronize! Pro X always copies only the files that have changed – there is no
difference in this respect between a “Synchronization” and a “Backup”. Because
of this, updating a synchronization or a backup is as simple as running it again.

Copy files over the Internet

Synchronize! Pro X works with Mac OS X to copy files over the Internet.
Synchronize! Pro X can compare and copy files on any disk which appears on the
OS X desktop. Mac OS X can connect to AppleShare, File Sharing, NFS and SMB
(Windows) servers.

File Synchronization

Synchronize! Pro X solves the problem of changing your documents on more
than one computer.

You’re familiar with the problem: you have a Mac at work and a PowerBook or a
Mac home, and you have some changes that you need to make in a few of your
documents. So you copy them onto your PowerBook or a removable disk, take
them with you, and change them. When you’re done with the changes, you
replace the older documents on your Mac at work with the newer ones.

Synchronize! Pro X automates the process of keeping the most recent version of
any number of documents on multiple Macs that you use, so that you don’t have
to worry about it.

Synchronize! Pro X will keep two folders on different Macs synchronized, and
always copy the newest document in a folder to the corresponding folder on a
PowerBook, another Mac, or on a disk you take with you.

File Server Backup and Mirroring

Synchronize! Pro X makes backups much more efficient by copying only files
that have changed. The first backup will still take a while, although it will be
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done as quickly as possible, due to the high-performance architecture of
Synchronize! Pro X. Subsequent backups take much less time, because only files
that have changed are copied again. This can speed up a backup by 90% or more.

With Synchronize! Pro X, you can keep a second file server as a “hot backup”. In
the event that the primary file server goes down, the second file server is
immediately available, with all files current as of the last scan.

Scans for differing files can be done as frequently as you desire, limited only by
the length of time required to complete a single scan.

A significant advantage of this approach over hardware-based disk mirroring is
that a failure of software on one server will often cause any disk access due to
that failure to be replicated on both mirror disks; a failure of any component of
the primary file server which renders the server inaccessible prevents bad data
from being written to the secondary server.

Selective Backup

Synchronize! Pro X will automatically keep the folders you choose (or your entire
hard disk) backed up to a second hard disk, one or more floppy disks, or to a file
server. If your main hard disk should ever fail, your most important documents
are safely backed up.

Keep Old Files

When files are replaced or deleted, they can be kept in an archive so that
previous versions of those files are available should you need them.  This feature
is called “Archive Files” in the Options menu.

File Distribution

Files which need to be delivered to one or more remote sites can be kept up-to-
date automatically.

Synchronize! Pro X can automatically connect to a remote server, copy the
newest files to the remote server, log off the server, and disconnect the modem,
at a preset time.

Using Synchronize! Pro X with disks on the desktop

Synchronize! Pro X works with any disk that appears on the desktop, whether it
is a removable disk, hard disk, or file server volume. The disk might be a
PowerBook in “FireWire Target Mode”, an AppleShare file server or a Mac with
File Sharing, an NFS disk, or a WebDAV server.

Once the disk appears on your desktop, choose any two folders for the
synchronization. Once you set it up, Synchronize! Pro X will copy any newer files
between two folders on any disk, automatically.
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Synchronizing remotely with removable disks

Macs in two different locations can be synchronized by carrying a removable
disk between them. Firewire disks are well-suited to this purpose because they
are small, portable, and many don’t require external power.

The idea is to synchronize a folder on each Mac with a folder on the removable
disk. Synchronize! Pro X copies only the documents which are newer from the
hard disk to the removable disk, so it takes less time.

As you move from one Mac to the other, use Synchronize! Pro X to copy any
newer documents to your portable disk. At the other Mac, use it again to copy
those documents to the hard disk.

All you have to do to keep the newest versions of your documents on both Macs
is to use Synchronize! Pro X when you leave one Mac, and when you arrive at
the other Mac. Your removable disk is also a backup of your most recent files.
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Getting Started

Installation

Installing Synchronize! Pro X is done with drag and drop. Drag the
“Synchronize! Pro X” folder, which contains the application and supporting
documents, to your hard disk. The folder may be on a CD or it may be in a
compressed archive which can be downloaded from the Qdea web site at
http://www.qdea.com      .

You can put Synchronize! Pro X in any location on your hard disk, although
many people put it in the Applications folder.

Try an example

The best way to learn about Synchronize! Pro X is to try it out. Here’s a simple
example:

1. Think of a folder that you’d like to backup or synchronize.
2. Open Synchronize! Pro X.
3. To set the folders to be synced, click on each folder, navigate to the

folder you want to sync and click Choose.
4. Click the Sync… button. Synchronize! Pro X shows the documents

which will be copied.
5. Click the Start button. Synchronize! Pro X copies the documents from

one folder to the other.

Note: Just like a word processor or a spreadsheet, Synchronize! Pro X
uses the contents of its setup documents to tell it what to do. In the case
of Synchronize! Pro X, its documents tell it what folders to synchronize,
and what options have been set.

If you click the “Sync” button again, Synchronize! Pro X reports that “The two
folders are the same”. This is because Synchronize! Pro X has copied all files
which are different to the other folder, making the folders identical. Because
Synchronize! Pro X copies files only when they are different, it has no more files
to copy.
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Using Synchronize! Pro X
This chapter discusses how Synchronize! Pro X works. It describes one way
Synchronize! Pro X can work for you.

The problem

The primary purpose of Synchronize! Pro X is to keep the most recent versions of
your documents on more than one disk.

This is best illustrated by two documents, A and B. For the purposes of this
example, Document A is on your Mac at work, and Document B is on your Mac
at home.

Document A is initially the same as Document B. While at work, you make some
changes to Document A. At home, an inspiration hits you, and you make some
changes to Document B.

You put Document B on a floppy disk, intending to update your Mac at work.
But wait! If you copy Document B onto your hard disk at work, the changes you
made to Document A will be lost!

Naturally, if you only worked with one document, you’d remember where you
made the last change. But it you hadn’t changed it in a while, it might be hard to
remember which location has the most current version of a document.

The solution

Wouldn’t it be nice if there were a way to automatically keep both locations’
documents up-to-date, so that any changes are always made to the most recent
version?

That’s what Synchronize! Pro X does for you, automatically.

Using Synchronize! Pro X with removable disks

To let Synchronize! Pro X solve this problem for you, create a folder on your Mac
at work. Call it “Working Documents”. This folder contains your working
documents, which are those documents you’re changing regularly.

Arrange the organization of your files so that your “Working Documents” folder
contains the files you’re working on. The contents of this folder should be
smaller than the size of the removable disk.

It’s OK to create as many folders within your “Working Documents” folder as
you need to keep a manageable arrangement. You might have, for example, a
different folder for each project you work on.
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Take out a new disk and label it “Travelling Disk”. This is the disk that you will
use to carry your updated files to your other Mac.

Create a folder on your new disk. Give it a name like “Travelling Documents”,
which shows that it contains the files that travel from one Mac to the other.

Set up a Synchronize! Pro X document which identifies the folder on your hard
disk and your “Travelling Disk” as “clones*”, or folders which are to be made
identical.

Check the “Reopen at startup” box in the document. Save it on your hard disk.

* In biology, a clone is an exact biological duplicate. Two people who are
clones have the same fingerprint. The idea here is that Synchronize! Pro X
will always keep these two folders identical, so that when you make a
change to a file in one folder, the newer file will replace the file in the
corresponding folder.

At home, create a similar “Working Documents” folder on your hard disk.
Create a Synchronize! Pro X document which identifies the “Working
Documents” folder on your Mac at home, and the “Travelling Documents” folder
on your removable disk. Check the “Reopen at startup” box in the document,
and save it on your hard disk at home.

Important! Make sure that the clocks on all Macs on which you use Synchronize! Pro
X are set accurately!

It’s critical to Synchronize! Pro X’s proper operation that the time of the clock on
your Mac is set correctly, since it is used to stamp the time your files are changed.
Use the “Date & Time” Control Panel to check the time of your Mac’s clock. The
time does not need to be accurate to the second, since you won’t be changing
files on more than one Mac at a time, but it should be accurate within five
minutes.

Your setup is complete. Now you’re ready to put Synchronize! Pro X to work.

Putting Synchronize! Pro X to work

Since Synchronize! Pro X compares the files in your “Working Documents”
folder with the files in your “Travelling Documents” folder and copies the
newest file to the other folder, run Synchronize! Pro X whenever you make
changes to any of your working documents.

It’s often easiest to run Synchronize! Pro X every day just before you go home, as
a routine part of leaving for the day, so that any documents you may have
changed during the day are copied to your “Travelling Disk”.

When you’re ready to use your Mac at home, run Synchronize! Pro X before you
start working. Any documents which have been changed at work are on your
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“Travelling Disk”; Synchronize! Pro X copies them to your "Working
Documents" folder on your hard disk at home.

When you’re finished making changes at home, run Synchronize! Pro X again
before you shut down your Mac, and run Synchronize! Pro X at work when you
arrive. Synchronize! Pro X copies any documents you changed at home to your
“Travelling Disk” and then to your Mac at work.

You’ve completed the cycle, always taking your working documents with you.
You didn’t have to compare the dates of your documents and drag the newest
ones to a removable disk, or copy an entire folder from your Mac to a removable
disk.

Synchronize! Pro X copies the files for you, and since it copies only the newest
ones, you spend as little time as possible keeping your files with you!

An added benefit of using Synchronize! Pro X is that you also always have a
backup of your most recently changes files, which are the ones least likely to be
backed up!

Using Synchronize! Pro X with a direct connection

If you have a way of connecting your Macs together so that the disks of both
Macs appear on your desktop, you can use Synchronize! Pro X without a
removable disk. There are several ways to do this, including using File Sharing
and AppleTalk or Apple Remote Access, or using “SCSI Disk Mode” for a direct
connection to the hard disk in some PowerBooks.

In this case, you need only one Synchronize! Pro X document. Choose a folder on
each Mac in the document, and save it. Whenever you make changes to your
documents, connect your Macs together and use Synchronize! Pro X to
synchronize your files.

If you use File Sharing and/or Apple Remote Access, Synchronize! Pro X can
make the connection to your remote Mac automatically. Please see the
description of the “Auto-Connect” option in the “Synchronize! Pro X Reference”
chapter.

How Synchronize! Pro X works

Synchronize! Pro X works by looking through the two folders identified in a
Synchronize! Pro X setup document, creating pairs of files and folders which
correspond to each other.
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This is a diagram of corresponding folders:

Working Documents

Personal

Proposals

Projects

Traveling Documents

Personal

Proposals

Projects
Corresponding Folders

Corresponding Folders

Corresponding folders

Each folder pair has the same name, except for the top-level folders, without
regard to capitalization. Each pair is also nested within the same folders on both
sides; for example, the two “Projects” folders correspond, but neither of them
could correspond with a “Projects” folder within the “Personal” folder.

The files in each folder pair are compared by name, without regard to
capitalization, to find file pairs. Each file pair is compared to determine if they
are the same; if they were last changed at exactly the same time (to the second),
they are considered to be identical.

If they are not the same, Synchronize! Pro X copies the newer file to replace the
older file.

Advanced Features

Synchronize! Pro X has a number of advanced features that make it more useful.
These features appear under the Options menu.

For example, it is possible to set up synchronization to occur when disks are
inserted, when a setup document is opened, at login, or periodically at a
particular time of day.

It is possible to connect to a file server or another Mac with File Sharing,
automatically supplying the password even if you aren’t present.

Synchronize! Pro X can recognize when you make changes to two different
versions of a document, warn you, and take appropriate action.

Finally, it’s possible for Synchronize! Pro X to automatically unmount or eject the
disk, completely automating file synchronization. If your Mac has the capability,
Synchronize! Pro X can shut down your Mac when it’s done.
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With these features, you can automatically synchronize in the middle of the night
when you aren’t using your Mac, and when telephone rates are at their lowest.

Or you can synchronize your files at the end of the day by inserting your backup
floppy or removable disk, making a backup of the day’s work while you go
home.

For more information on these features, please see the description of the Options
menu in the “Synchronize! Pro X Reference” chapter.
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Making a bootable OS X Backup

The following tutorial covers the steps needed to set up Synchronize! Pro X to
make a bootable backup of your OS X system. A bootable backup can be made to
a local hard disk such as a FireWire or IDE disk, but not to a file server. This
procedure gives you a bootable copy of your system, so that if your main hard
disk fails, you start up your computer from the backup disk and continue
working with your computer, just as it was as of the last backup.

Make sure your Mac knows what time it is

Make sure that the clock on your Mac is set correctly!

It’s critical to Synchronize! Pro X’s proper operation that the time on your Mac is
set correctly, since it is used to stamp the time your files are changed. Use Date
and Time in the System Preferences to check the time of your Mac’s clock. The
time does not need to be accurate to the second, but it should be accurate within
five minutes.

Erase the backup disk

Please note: In order to be bootable, the backup destination must be a disk on the desktop,
not a folder on a disk.

The first time you back up your OS X system, the destination disk needs to be
erased.

1. Open Disk Utility.
2. For Intel Macs, check the “Partition Map Scheme” for your backup disk. This

info is listed at the bottom of the window when the physical disk is selected.
It’s important that it is “GUID Partition Method”. If it isn’t, we recommend
that you do this:

2a. Click the Partition tab.
2b. Use the “Volume Scheme” popup menu to choose “1 Partition”. (You

can choose more than one partition if you wish.)
2c. Click the Options button.
2d. Click “GUID Partition Scheme”.
2e. Click OK.
2f. Click the “Apply” button.

3. Erase the destination disk for the backup using the “Mac OS Extended,
Journaled” format.

4. Quit Disk Utility.

You don’t need to erase the disk again, once you’ve done a backup, but only the
first time you set up the disk to be a bootable system disk.
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Open Synchronize! Pro X

Double-click the Synchronize! Pro X application icon to open the application.
The icon looks like this:

Synchronize! Pro X application icon

Setting up the backup

Synchronize! Pro X setup documents describe two folders or disks which are to
be synchronized or backed up.

New document window

Note: To set up a system backup, the source and destination disks must be visible
on the desktop.

To set up a setup document for backing up your system, follow these steps:

1. Close any open Untitled window.
2. Use the File menu to choose “New”.
3. Click on “Bootable System Backup”.
4. Click OK.



Making a bootable  OS X Backup 12

5. Enter your administrator name and password and click OK.
6. Click the icon for “Folder B”. Use the dialog to choose the destination

disk.

Tip: You can also drag the icon for the disk over the folder icon and
release the mouse.

7. Uncheck the “Show files to copy” box. There is generally no need to
show the list of files to be copied, and this step takes some time. Please
note that this causes the backup to proceed without interruption, so it is
critical that you’ve chosen the correct destination.

8. Save the setup document for future use. You may want to check the “Re-
open at startup” box. When this box is checked, the backup document
will be automatically opened when you open Synchronize! Pro X.

Starting manually

Every time you click the “Sync…” button, Synchronize! Pro X checks the contents
of the two disks or folders shown in the document. When it encounters a file
which is newer than the corresponding file, or which doesn’t have a
corresponding file, it marks the newer document to be copied to the other folder.

To manually start the backup, click the “Sync…” button. The Status window
shows files as they are copied.

Any errors will be shown in a dialog and noted in the Log.

Starting up from a bootable backup

One way to start up from a backup disk is to choose the disk using “Startup
Disk” in the System Preferences.

Sometimes the computer isn’t running. To start up from any bootable backup
disk, hold the Option key down when starting up the computer. After a period of
time, you’ll see a window which shows you the available disks. Click on the disk
you want to start up from, then click the right arrow.
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Six Ways To Use Synchronize! Pro X
1. Backup the system disk to another hard disk.

Synchronize! Pro X will backup the contents of any Mac OS X system disk to
another hard disk, including the files’ owners, groups and permissions, such that
the backup disk is bootable.

If your hard disk fails, the computer can be started up from the backup hard
disk, immediately making it available.

To set it up, use the File menu to choose New. Click the “Bootable System
Backup” button. Click OK. Click the folder icons to set the system disk as the
Master, and the destination as another hard disk.

In order for the backup disk to be bootable, Synchronize! Pro X must be run with
the “Setup type” popup menu set to “Bootable System Backup”.

2. Keep folders on two Macs the same.

This is called “file synchronization”. It is a common use for Synchronize! Pro X.
To set up Synchronize! Pro X for file synchronization, use the File menu to
choose New. Click the “Synchronization” button, then click OK. To choose the
folders to be synchronized, click each folder icon.

Remember that more than one folder can be synchronized by using a
Synchronize! Pro X setup document for each folder, or by using aliases to other
folders. When using removable disks for large numbers of files, more than one
removable disk can be used, as long as each removable disk can contain the
contents of the folder it is synchronized with.

3. Back up your hard disk to a file server or a removable disk.

Synchronize! Pro X will make a backup of all or part of your hard disk to any file
server that you can see on your Mac OS X desktop. Synchronize! Pro X will also
backup to a removable disk.

To make an exact backup, use the File menu to choose New. Click the Backup
button, then click OK. Click the folder icons to set the folder to be backed up, and
the destination folder.

Use Start Options (in the Options menu) to “Start copying when document is
opened”. When you’re ready to go home, open the backup document.

As an alternative, use Start Options to set up an automatic backup daily, at a
particular time. Synchronize! Pro X will be automatically opened at the
appropriate time to perform the backup.
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4. Distribute files to one or more remote Macs or file servers.

This makes document distribution to other sites easy – just start the
synchronization, and the remote disk will be mounted automatically!

Since Synchronize! Pro X copies only the information which has changed, your
Remote Access connection need not be in use any longer than necessary, saving
you money in telephone bills.

Synchronize! Pro X will keep the files and the folder organization at the remote
locations identical to your master site if you: a) check the “Master” box for the
folder at the master site and b) check the “Delete files and folders not in the
master folder”  box.

Use “Auto-Connect” in the Options menu to enter the passwords for the file
server, so that the connection can be made automatically, when you are not
present.

Check “Unmount disk when complete” in the Completion Options to
automatically disconnect when synchronization is complete.

Finally, to completely automate the activity, set a start time and how often the
synchronization should take place in the Start Options.

5. Move files automatically.

Synchronize! Pro X will automatically move files which are older than a preset
number of days to a different disk, or a different Mac on the network.

Use this feature to move older files from an expensive disk array, freeing space
for new files.

To set it up, use the Options menu to check “Move files”. Use “Copy only
files…” in the Options menu to set how old files which are moved must be.

6. Keep multiple Macs running as Web servers up-to-date with the latest content.

Macintosh computers are often employed in a Web site as a RAIC, or Redundant
Array of Independent Computers.

A RAIC has several advantages: redundancy, so that the failure of any one
machine doesn't bring down the Web site; the ability to serve very high
bandwidths, because each Mac handles part of the load; and low cost.

Synchronize! Pro X is optimized to keep the Web content identical on the many
redundant computers in a RAIC, while the servers are being accessed, so that
changes can be made transparently during normal server operation.

The army.mil web site and others use Synchronize! Pro X for this purpose.
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Tips and Techniques

This chapter describes ways to get more out of Synchronize! Pro X, and how to
simplify its day-to-day use.

Using Synchronize! Pro X automatically

Once you’re familiar with the operation of Synchronize! Pro X, you’ll probably
want to use it with a minimum of fuss. The following tips automate the use of
Synchronize! Pro X and its documents, so that it’s a simple part of your normal
routine.

• Put an alias to Synchronize! Pro X in your Favorites folder. Drag your
Favorites folder in the Dock. When you want to synchronize your files, just
choose Synchronize! Pro X from the folder – click and hold until a menu
appears, find Synchronize! Pro X, and choose it.

• Use the Options menu to choose “Start Options.” Check the “Start
synchronization when document is opened” box to automatically start a
synchronization. Save the setup document (or an alias to it) in your Favorites
folder, and put your Favorites folder in the Dock, so that choosing the item in
the folder automatically starts the synchronization.

• Check the “Reopen at startup” box. When this box is checked, your
document will be automatically opened when Synchronize! Pro X is opened,
and you won’t have to find and open the document manually.

• Don’t check the “Show files to copy” box. This eliminates the window that
allows you to examine the files and/or folders to be copied.

• Use the “Auto-Connect” feature. If you synchronize with an AppleShare
server or File Sharing, use the “Auto-Connect” option to enter your
passwords so that a connection can be made without having to re-enter
them.

Starting syncs with AppleScript

Any sync setup document can be executed with AppleScript.

Here is an example script:

tell application "Synchronize! Pro X"
-- Open a synchronization document
open file "Sync Server"
-- If the Start Option "Start synchronization when the
-- document is opened" is checked,
-- the synchronization will be automatically started.
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-- Start a synchronization
sync file "HardDisk:Sync My Documents"
-- Synchronize! Pro will automatically open the
-- specified document (if it's not already open)
-- and start its synchronization

-- Quit Synchronize! Pro
quit

end tell

An AppleScript can also be executed when a sync completes. Please see
Completion Options in the Reference section for more information.

Keeping old files in an archive

As you modify your files, Synchronize! Pro X copies the newer file to replace the
older file. You may want to keep the older files around. When you enable
archiving, replaced and deleted files are moved to an archive folder instead of
being deleted.

Given the large size of hard disks, all of your old files may fit in the free space on
your backup drive.

Use “Archive files…” in the Options menu to enable archiving. Create and
choose a folder that you want archived files to be saved in.

If you want to keep a certain amount of free space on the disk containing the
archive,  check “Preserve free space” and enter the amount of space, in
megabytes, that you want to keep free.

You may want to write your old archived files to CD-R or DVD-R. To organize
the archive into groups which fit conveniently on your backup media, ccheck
“Group archive folders” and set the size to 650 MB for CD-R or 4700 MB for
DVD-R.

With “Group archive folders” active, each folder in the archive folder will
occupy  no more than the designated space. A completed group folder will have
a name like “3137568331 Wed, Jun 4, 2003 10-45-31 AM”, while the group
folder that’s being filled has the name “Current Group”.

Once you save a group folder to CD-R, you can free the space it occupies by
dragging it to the Trash and then emptying the Trash.

You may not care about archiving files that you didn’t create or modify, such as
OS X system files. In this case, use “Archive files only in certain folders” to
archive files that are within your home folder.
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Synchronizing with removable disks

If you carry files between two Macs on removable disks, it’s more convenient to
synchronize automatically when you insert your removable disks.

AutoSync, a small background application, can automatically start a
synchronization when you insert your removable disks. It is installed
automatically by Synchronize! Pro X, and can be installed manually from the
Preferences.

• Use the Options menu to choose Start Options. Check the “When disks
become available” box to start synchronization when you insert your
removable disk. Click OK.

Synchronize! Pro X asks you if you would like a startup application installed
which will automatically open Synchronize! Pro X at the appropriate times.
Click Yes.

Synchronize! Pro X installs AutoSync in your Applications folder. AutoSync
is set to run at login in the Login pane of the System Preferences.

• Choose the “When copying is complete, Quit” option in the Completion
Options. Then set Synchronize! Pro X to run in the background.

• You may want to check one or both of the “Start copying at Login”     and     
“Start copying when disks are available” boxes. This causes the document to
be automatically started when you log in to your computer, and when you
insert the disk.

• Be sure to save your synchronization setup (it doesn’t matter where).

With these options set, Synchronize! Pro X will automatically synchronize your
files when you insert your removable disk. All you have to remember to do is to
take the disk with you!
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Synchronize! Pro X Reference

This chapter describes each of the features of Synchronize! Pro X and how to use
them.

You may find it most helpful to read a portion of this chapter when you have a
particular question, rather than read it all at once.

Synchronize! Pro X Windows

Document Windows

Synchronize! Pro X document windows describe two folders whose contents will
be made identical. You choose the folders that will be compared in a document
window. A document window looks like this:

Document window

Synchronize! Pro X document windows represent the contents of a setup
document. Each setup document contains all the information on a single
synchronization setup. The document window and the Options menu make it
easy to change the settings.

Choosing Folders

To change the folder to be synced, click on the folder icon. Navigate to the folder
you want and click Choose.
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Folders can also be set by dragging them into a document window from the
Finder.

Command-click a folder to see the location of that folder on the disk.

Setup type popup

Use the Setup type popup to conveniently set up a synchronization, a normal
backup, a bootable system backup, or a verify operation. Use the “Custom”
option for the flexibility to choose any combination of settings. The most
common custom setup is a one-direction sync with no master; with this setup,
files are copied in the direction of the arrow, but only those files which are newer
are copied, and files which have been deleted from the source folder are not
deleted from the destination folder.

A “Synchronization” compares files and copies the newer file to replace the older
file, while a “Backup” always copies files in one direction. In general, it’s best to
use a “Backup” if you want to make the destination look like the source, because
there’s less room for error and a “Backup” takes less computer resources.

Synchronize! Pro X always copies only the files that have changed – there is no
difference in this respect between a “Synchronization” and a “Backup”. Because
of this, updating a synchronization or a backup is as simple as running it again.

Master check box

When the box titled Master is checked, the folder above it is considered a “master
folder”. No files in that folder will be replaced, even by newer files. Any file in
the Master folder which is different from a corresponding file in the other folder,
whether newer or older, will replace the file in the other folder.

This feature makes Synchronize! Pro X copy files in one direction only. This is
useful when you use Synchronize! Pro X to create a backup of your work.

When neither Master box is checked, only newer files will replace older files;
older files will not replace newer files.

Copy Direction Arrow

The arrow between the two folders in a document indicates which direction files
and folders will be copied or moved.

When the arrow points in both directions, files will be copied in either direction,
depending upon which file is newer. The file which is replaced will always be
the older or nonexistent file. This is the normal setting for file synchronization.

When the arrow points in one direction, files will be copied only in the direction
of the arrow.
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The Master check box below a folder identifies the folder as containing files
which are considered “master files”, regardless of age. When a Master box is
checked, files will be copied in the direction of the arrow only, replacing corresponding
files which are newer     or     older.

When Move files in the Options menu is checked, the word “MOVE” will appear
above the arrow. This indicates that the files will be moved to the destination
folder, not duplicated.

With a “Custom” sync setup, an alternate way of setting the direction of the
arrow is to click on the arrow. Each time you click, the folder which is the master
will change, and the arrow will change as well.

Delete files and folders not in the master folder

Check this box to delete any file or folder which is not in the Master folder.

The effect of checking this box is equivalent to using the Master folder to replace
the other folder. Synchronize! Pro X does this as efficiently as possible, however,
by replacing only the files which are different.

Use this option to create a backup of a folder on your hard disk.

This option is active only when one of the Master boxes is checked, and “Move
files” in the Options menu is not checked.

Show files to copy

When “Show files to copy” is checked, Synchronize! Pro X shows you what files
will be copied. When it is not checked, Synchronize! Pro X starts copying without
requiring you to dismiss a dialog box.

Reopen at startup

To cause your synchronization setup document to be reopened every time
Synchronize! Pro X is opened, check this box.

Synchronize! Pro X saves information on whether a document is to be reopened
at startup only when the document is saved. This means that if you checked the
box and did not save the document, the document will not be reopened the next
time you open Synchronize! Pro X.

The first time you run Synchronize! Pro X on a different Macintosh, you will
have to manually open any documents which have “Reopen at startup” checked,
so that Synchronize! Pro X knows where they are.



Synchronize! Pro X Reference 21

Sync… button

The Sync… button initiates the synchronization of the two folders shown in the
window. If the “Show files to copy” box is checked, a dialog shows the files and
folders which will be copied or deleted. If the box is not checked, copying starts
immediately.

When you click the Sync button of a document window and “Show files to copy”
is checked, Synchronize! Pro X shows what files and folders need to be copied
and deleted in a window like this:

Files to copy window
This dialog shows what actions Synchronize! Pro X must take, in what order, to
make the folders identical. Files and folders may need to be copied or deleted,
depending upon the option settings.

To see how many files are to be copied in a particular folder, click on that folder.
To open or close the folder and all folders below it, click on the triangle to the left
of the folder.

Icons are used to show the different actions to be taken during the
synchronization. The descriptions which follow refer to the actions in the “Files
to copy” dialog illustration above.

1. The folder “Personal” will be created in its appropriate place within the
folder “Travelling Documents”.
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2. The file “Letter to Mom” will be copied to the folder named “Personal”.

3. The folder “Temporary Stuff” will be deleted.

4. The file “Proposal (DRAFT)” will be deleted.

5. The file “Flight Confirmation” will be copied to the folder named
“Trips”.

Note that when a file is selected, the modification dates for the file and its
corresponding file, if one exists, will be shown below, as well as the
difference in time between the modification of the two files.

Left and right arrows indicate the direction that files will be copied. They are
different colors to make it easier to see a file that is being copied in the opposite
direction.

A red arrow pointing to the left or right indicates that the file will be copied such
that the newer file will be replaced with an older file. This is often an occurrence
of special significance.

Shortcuts in the Files to Copy window

Use the up and down arrow keys to change the selected line. Hold down the shift
key to add lines to the selection.

The number of files to be copied and deleted for the current selection is
displayed at the bottom of the window.

Click the triangles to hide or reveal the contents of a folder. Double-click for the
same effect.

Command-click a triangle to close or open all folders at the level which are slso
within the same parent folder.

Option-click a triangle to close or open all folders inside the folder which is being
closed or opened.

Command-click the icon of a file or folder to see a menu showing the path of that
folder. Choose “Show In Finder” to show the file or folder in a Finder window.

Option-click the icon of a file or folder to copy its path. Pasting the copied text
into Terminal or another path-oriented application will allow direct access to the
file or folder.

Double-click a file to change the direction that it will be copied. If a file has been
marked to be deleted, double-click to restore its original state.
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 “Delete” button

The “Delete” button causes any selected files to be marked for deletion. Once the
synchronization is started, the files will be deleted with no further warning.

The effect of this button can be reversed by double-clicking the same files, or by
removing them from the list.

Remove from list

The “Remove from list” button removes any selected actions from the list. Use
“Remove from list” to manually tell Synchronize! Pro X not to copy, move, or
delete a particular file or folder.

Sometimes removing an action from the list requires that other actions also must
be removed. For example, removing a folder to be created from the list requires
that any files to be copied into that folder must also be removed. When such
situations arise, Synchronize! Pro X will warn you and ask whether you want to
remove all affected items.

“Donʼt copy” button

The “Don’t copy” button removes any selected items from the list and
remembers those items so that they are not copied in the future. Use “Remove
from list” to manually tell Synchronize! Pro X not to copy, move, or delete a
particular file or folder, and to not copy the file or folder in all future syncs or
backups.

This button adds specific files to the “Don’t copy files…” list, and folders to the
“Don’t copy folders” list. Use the Options menu to see these lists.

To review or remove files or folders from the “don’t copy” lists, hold down the
option key and click the “Don’t copy” button. Remember that any changes you
make to the settings will only affect the files and folders that will be copied after
you start a new sync or backup – they will not affect the sync or backup
performed when you click the “Start” button.

Reversing copying direction

Sometimes you may discover that a file which is to be copied should not replace
an older version of the file. To reverse the direction the file will be copied,
double-click the file.

When an older file will replace a newer file, the arrow will look like this:   
To reverse the direction again, double-click the file again.
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Cancel

The Cancel button cancels the actions shown in the dialog. When you click
Cancel, no files or folders are copied or deleted.

Start

The Start button initiates the copying actions shown. If no other copying is in
progress, copying will start immediately. If other copying is in progress, the
synchronization will be placed in the Waiting List until the other copying is
complete.

Status Window

The Status window shows the status of the most recent copy operation. When
copying is active, the Status window shows how far the copying has proceeded
toward completion. This is what the Status window looks like:

Status Window

Stop

The Stop button stops copying. Normally, when copying is stopped, a file which
has been partly copied will not be affected. However, if there is very little free
space on the disk, a partially-copied file may be deleted from its destination
without being replaced. Any deleted file is always the file to be replaced.

Pressing the command and period keys at the same time when the Status
window is active has the same effect as clicking the Stop button.
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Continue

The Continue button resumes copying which has been paused. Pausing has no
detrimental effect on the completion of the synchronization.

Pause

The Pause button temporarily suspends copying. Use the Pause button when you
want access to your Mac without the background activity of copying.

Pause is useful when you’ve thought of one small thing you wanted to do before
you leave.

Waiting List Window

The Waiting List window shows a list of all documents whose synchronization is
waiting to be started. This is what the Waiting List window looks like:

Waiting List Window

Use the Waiting List window to monitor multiple synchronizations which are
waiting to be started. Double-click on a document name to bring that document’s
window to the front. Command-click a document to see the location of that
document on the disk.

If there are several syncs or backups waiting to be started, and you don’t want to
start them, hold down the Option key after canceling the operation. If the Option
key is down, the waiting syncs or backups won’t be started.
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Remove from list

Use the “Remove from list” button to cancel a waiting synchronization
operation. Select the operation to be cancelled before clicking the button.

Up and Down Buttons

Use the Up and Down buttons to change the order of the list. The first item (the
one at the top) will always be the next one to start.

The Waiting List is useful for starting several synchronizations when it will take
some time for them to complete. If the “Show files to copy” box is not checked
for these synchronizations, they will proceed as soon as the current
synchronization is complete.

Auto Syncs Window

The AutoSyncs window shows a list of the sync documents that are set to run
automatically.

Auto Syncs Window

Double-click on a document name to bring that document’s window to the front.
Command-click a document to see the location of that document on the disk.

Use the Auto Syncs pane in the Preferences to install the AutoSync background
application and to affect how it operates.
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Open button

Use the Open button to open a document and bring it to the front. Double-
clicking a document in the list has the same effect.

Remove button

Use the Remove button to close a sync setup document and remove it from the
Auto Syncs list. This prevents the document from being started automatically. If
the document is opened again, it will be automatically added to the Auto Syncs
list.

Log Window

The Log window shows the contents of the log. The date, time, and results of
each synchronization are normally stored in the log.

Position the Log window conveniently; its position will be remembered.

To select portions of the text in the Log window, click on the text and drag. The
selected text is highlighted. To copy the selected text, choose Copy from the Edit
menu.

Selected text in the Log can be dragged directly to another application.

Use the Log pane in the Preferences to affect the way the log is displayed.



Synchronize! Pro X Reference 28

Synchronize! Pro X Menus

This section describes the menus in Synchronize! Pro X and how to use them.

Synchronize! Pro X Menu

Preferences

Choose Preferences to show the Preferences window.

The Preferences window has many panes. Choose a pane with the popup menu
or with the right and left arrows.

Settings in the Preferences window apply to all Synchronize! Pro X documents.

General Preferences Pane

General Preferences Pane

Donʼt open an Untitled window at startup

Check this box to avoid opening a new Untitled window every time you open
Synchronize! Pro X.
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When copying is complete, play

Check this box to play a sound when copying completes. When this box is not
checked, no sound is played.

Use the popup menu to choose the sound that will be played. If the sound shown
in the popup menu is gray, the chosen sound is not available, and you should
choose a different sound.

Donʼt show ʻno files to copyʼ dialog

Check this box to skip showing the dialog box that says, “There are no files to
copy”. This is a convenience for those who prefer not to have to dismiss the
informational dialog.

Ask Finder to eject disks

Check this box to cause Synchronize! Pro X to send Apple Events to the Finder to
eject a disk, instead of using system calls. This may cause the Finder to clean up
any open files prior to attempting to eject the disk.
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Defaults Pane

Defaults Preferences pane

Settings in the Defaults Preferences pane affect which setup types are available
when “New” is chosen from the File menu.

To disable a particular setup type, click the “Disable” box for that type

To change the setup type which is initially shown, click the desired setup type.
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Warnings Preferences Pane

Warnings Preferences pane

Settings in the Warnings Preferences pane establish criteria for warnings issued
about potential problems, such as replacing all one’s files. Such a problem can
occur when a backup is done in the wrong direction, for example.

Warn me if more than 50 percent of the data will be deleted

Check this box to show a warning before deleting more than a certain fraction of
the total data in the top-level folder.

Warn me if more than 50 percent of the files will be deleted

Check this box to show a warning before deleting more than a certain fraction of
all files in the top-level folder.

Warn me if more than 50 percent of the files will be replaced

Check this box to show a warning before replacing more than a certain fraction
of the total data in the top-level folder.
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Always warn for automatic syncs
Cancel automatic syncs after warning for 1 minute
Donʼt warn for automatic syncs

Use these settings to determine what happens when an automatic sync occurs.
Automatic syncs occur on a scheduled basis, when a disk is made available, or at
login. To set syncs to run automatically, use the Options menu to choose Start
Options.

Monitoring Pane

Monitoring Preferences pane
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Settings in the Monitoring Preferences pane enable web-based monitoring of
your backups. Using the Qdea Backup Monitor, you can receive emails when
your backups run successfully, have errors, are missed, or don’t run to
completion.

To enable or disable monitoring for the computer, click the “Enable monitoring”
box.

When your backups are monitored, you may want to add more information on
which computer is being monitored. You may optionally enter a description of
the location of the computer.

Click “More Info” to be directed to a web page on the Internet that describes
backup monitoring in more detail.

Files To Copy Pane

Files To Copy Preferences pane

Settings in the Files To Copy Preferences pane affect formatting of the Files To
Copy window, which is shown after folders are scanned for a backup or
synchronization.
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Set the desired font and type size using the popup menus.

When Always use generic icons is not checked, Synchronize! Pro X attempts to
get specific icons for the files and folders that are shown. This can slow the
display of the contents of the Files To Copy window. When this box is checked,
specific icons are not shown, and no additional disk access is made.

When Use generic icons for network volumes is checked, specific icons for
files and folders that reside on shared disks are not shown. This can improve
display and scrolling speed of the contents of the Files To Copy window for
shared disks that are connected over a slow network.

When Initially open all folders, including packages is checked, the contents of
all folders are shown when the Files To Copy window is opened. If you don’t
want to see items which are inside packages, leave this box unchecked.

File Change Pane

File Change Preferences pane

Settings in the Defaults Preferences pane affect which setup types are available
when “New” is chosen from the File menu.

To disable a particular setup type, click the “Disable” box for that type



Synchronize! Pro X Reference 35

To change the setup type which is initially shown, click the desired setup type.

Disk Errors Pane

Disk Errors Preferences pane

Settings in the Disk Errors Preferences pane affect the handling of errors which
occur while trying to find the disks for a synchronization.

Synchronize! Pro X normally uses an invisible file at the top level of each disk to
uniquely identify it. If you want a disk to be found by its name only, check Use
name only to identify a volume.

This can be useful if you want the same backup to work for two different disks.
Remember, however, that two disks with the same name (for example, a local
disk and a network disk with the same name) might be confused if this box is
checked.

To announce an error and wait for user interaction, click Wait forever.
To continue with other synchronizations if a disk can't be found, click If a disk
isn't available, Cancel. Set the number of minutes you want a dialog to announce
the error before being automatically dismissed.
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File server disks that aren’t available when the sync is started can be mounted
automatically using the Auto-Connect options.

File Errors Pane

File Errors Preferences pane

Settings in the File Errors Preferences pane affect the handling of errors which
occur while copying files.

Wait forever

Click this button to cause Synchronize! Pro X to show any errors in a dialog box
until it is dismissed.

Skip immediately and log the error

Click this button to cause Synchronize! Pro X skip the file for which the error
occurred and proceed to copy the next file. Errors are always entered in the Log.

Retry, Skip, or Cancel

Click these buttons for the action you want performed after a particular time.
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To cause a sync to be cancelled without showing an error dialog, set the number
of minutes to zero.
Beep

Check this box to have Synchronize! Pro X beep when an error occurs. The beep
sound is set with the “Sound” pane of the System Preferences.

AutoSync Preferences Pane

AutoSync Preferences pane

Settings in the AutoSync Preferences pane affect the installation and operation of
the background application AutoSync

AutoSync is a faceless background application which normally runs whenever
the user is logged in. It monitors the current time and the disks that are present.
When a synchronization is supposed to start, AutoSync will launch Synchronize!
Pro X and tell it to start the sync.

If AutoSync is not running, no automatic operations will occur in Synchronize!
Pro X. These operations include starting a sync at a scheduled time, starting a
sync when disks become available, and starting a sync when you log in.
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Install AutoSync

Click this button to install AutoSync manually. AutoSync is not installed if the
version currently installed is newer or the same as the version distributed with
Synchronize! Pro X.

To unconditionally re-install the version distributed with Synchronize! Pro X,
click the button while holding down the option key.

Donʼt install AutoSync automatically

Check this box to prevent Synchronize! Pro X from asking to install the
background application AutoSync. If this is checked, the only way to install
AutoSync is to click the Install AutoSync button.

Donʼt add AutoSync to the login list

Check this box to prevent Synchronize! Pro X from modifying the login startup
list. This is a list of applications that are started when you log in. The applications
are shown in the System Preferences Login pane.

Normally, when AutoSync is installed, AutoSync is added to the list of login
startup applications, so that automatic operation will occur whenever you log in.
Remember that if AutoSync is not running, automatic operations won’t occur.

Open Synchronize! Pro X in the background

Check this box to open Synchronize! Pro in the background when it is launched
automatically. This setting will have no effect on Synchronize! Pro X if it is
already running.

Hide Synchronize! Pro X after launch

Check this box to hide Synchronize! Pro when it is launched automatically. This
causes all of its windows to be hidden, making its operation less intrusive.
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Log Preferences Pane

Log Preferences pane

Settings in the Log Preferences dialog box affect how the Log is displayed and
used.

Show Log window at startup

Check this box to show the Log window every time Synchronize! Pro X is
started.

Font

Use the popup menu to choose a font for the text displayed in the Log window.

Size

Use the popup menu to choose the size of the text displayed in the Log window.

Limit Log file size
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Enter the maximum number of lines allowed in the Log file. When the number of
lines in the Log file exceeds this value, the oldest entries in the Log file are
removed.

The range for this number is 32 to 4096. The larger the log file, the longer it will
take to open the Log at startup.

Donʼt save anything in the log

Check this box to prevent any information from being saved in the Log.

Log the names of copied files

Check this box to enter the name of each copied file in the Log.

Include file path

Check this box to include the complete path of each copied file in the Log. This
may slow down the copying operation due to the large amount of information
written to the Log.

File Menu

Use the File menu to create and save Synchronize! Pro X documents.

New

Use New to create a new setup document. A Synchronize! Pro X setup document
contains the information describing two folders to be synchronized.

Open

Use Open to open an existing setup document. When a setup document is
opened, a window appears to show the contents of the document.

Close

Use Close to close the active window. Windows generally show the contents of a
setup document. Status, Waiting List, and Log are windows which are always
present, although they are not always visible. Closing a window dismisses it and
makes it disappear.

Save

Use Save to store the contents of a window in its setup document. Synchronize!
Pro X setup documents contain all the settings for synchronizing two folders.
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Save As…

Use Save As… to store the contents of a window in a different document which
you name.

Revert

Use Revert to discard any changes you have made to a document since you last
saved it. Revert is useful when you try some different settings and decide that
you liked it better the way it was.

Quit

Use Quit to exit the application. If copying is still underway when you quit, you
will be asked if you really want to quit. While the dialog is shown, copying
continues. If you leave your Mac alone until copying completes, Synchronize!
Pro X will quit when it is done.

Edit Menu

Undo, Cut, Copy, Paste, and Clear

Undo, Cut, Copy, and Paste functions are available for editing text in dialogs and
for copying the selected contents of the Log.

Any changes made to a document since the last time it was opened or saved may
be undone by choosing Revert from the File menu.

Options Menu

The Options menu contains many ways of affecting how two folders are
synchronized. All items displayed in the Options menu apply to the active
window. When the active window changes to a different document window, the
Options menu changes to reflect the options set for that setup document.

When options that affect the operation of the setup document are changed from
their initial settings, a diamond is displayed next to that menu item.

When the active window is not a document window, the Options menu is
disabled.

Wake up…

This wakes a sleeping computer if it’s connected to Ethernet.
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Wake up settings

In order for this feature to work, the computer to be awakened must be
connected to Ethernet and it must have its “Wake for network administrator
access” box checked in the Energy Saver panel in System Preferences.

Wake up computer A

Check this box to wake a sleeping computer prior to running the sync. Enter the
Ethernet Hardware Address for the computer to be awakened.  This address is
found in the Network panel in System Preferences.

Wake up computer B

Check this box to wake a second sleeping computer prior to running the sync.
Enter the Ethernet Hardware Address for the computer to be awakened.  This
address is found in the Network panel in System Preferences.

Auto-Connect…

Auto-Connect allows the user name and password for a file server to be set in
advance, so that the file server disk can be mounted automatically.
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Auto-Connect settings

Automatically connect “G3 Powerbook”

Check this box to automatically mount a file server disk. Enter the user name and
password needed for the file server.

This box is active only for folders which reside on an AppleShare file server, or a
Macintosh running File Sharing.

Retry button

Use this button to set how many times to try connecting to a file server, or Apple
Remote Access.
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Retry settings

Ask for the password

Click this option to try connecting with an alias. This will require a password to
be entered.

Allow for a manual connection

Click this option to allow a manual connection. Synchronize! Pro X shows a
dialog box and waits for the connection to be made.

Quit trying

Click this option to abandon the synchronization attempt if the file server cannot
be found. When this option is chosen, other synchronizations proceed without
delay.
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Start Options…

Choose Start Options… to set a sync to run automatically.

Start Options settings

Start synchronization at login
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Check this box to start synchronization immediately when you log in. The
document will be opened and the sync started at login. The background
application AutoSync must be set to open at login for this option to be functional.

Start synchronization when this document is opened

Check this box to start synchronization immediately when the document is
opened. This works the same as if you clicked the Sync button when you open
the document.

Use this option to automatically synchronize your files by double-clicking the
document.

Start synchronization when disks become available

Check this box to start synchronization when both disks needed for a
synchronization become available.

When both disks are available, the setup document will be opened, and
synchronization will begin.

A common use for this feature is to automatically start synchronization to a
floppy disk when it is inserted.

To start synchronization with this feature, the background application AutoSync
must be running before both disks become available. In order to take full
advantage of this feature, it is recommended AutoSync be set to open at login.

Start synchronization before Quit

Check this box to have Synchronize! Pro X start a synchronization before the
application quits. This can trigger a synchronization while the computer is
shutting down. Another way to accomplish this is to start the synchronization for
this setup, and have Synchronize! Pro X shut down the computer when the
synchronization is completed.

Start synchronization when folder changes

Check this box to start a synchronization when the contents of a folder changes.
You can choose to watch the contents of as many as two folders.

To prevent constant synchronizations, the minimum amount of time between
synchronizations can be adjusted.

This feature is available only when running on OS X 10.5 and later.
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Start synchronization at a preset time

Check the “On Sunday…” box to start synchronization at a particular time. To
set the time, click the time and use the up and down arrows, or type.

This option is effective only when Synchronize! Pro X is running before the
synchronization is set to start.

Start again every…

Check this box to start synchronization periodically. Enter the amount of time
between synchronizations. Use the popup menu to set the time in minutes,
hours, days, weeks, months or years.

Each time a synchronization is completed, the start time is reset.

Start only on...

Check this box to start synchronization only on certain days. Use the popup
menu to choose which days synchronization will be started.

Don't Start button

Click this button to set a period of time during which synchronizations will not
be started. This is often used to create a "window" of time during which a backup
is not performed.

AutoSync

When you click the “OK” button with synchronization set to occur at login, at a
preset time, or when disks are available, you are asked if you would like
AutoSync, a background application, to be installed.

AutoSync checks for conditions that you have set for starting synchronization,
and automatically launches Synchronize! Pro X when those conditions are met.



Synchronize! Pro X Reference 48

Completion Options…

Choose Completion Options… to set actions to be taken when a sync completes.

Completion Options settings

When copying is complete:

Check this box to perform one of the actions shown when copying is complete.
Only one action can be chosen at a time.

Close this document

Click this radio button to close the document when copying is complete.



Synchronize! Pro X Reference 49

Quit

Click this radio button to quit when copying is complete. Note that Synchronize!
Pro X will not quit until all copying is complete, even if the document containing
this option is the first one started.

Unmount “G3 Powerbook” when complete

Check these boxes to unmount or eject a disk when copying is complete. When a
disk is ejected or unmounted, the action is equivalent to dragging the disk to the
trash.

The disk containing the active System cannot be unmounted.

A hard disk or removable disk containing one or more open files cannot be
unmounted.

Force unmount

Check this box to cause a disk to be unmounted even if files on it are open. When
Ask Finder to eject disks is checked on the General page of the Preferences, this
setting has no effect.

Open the file

Check this box to open a file when copying is complete. Click the Choose…
button to choose the file to be opened. This is useful for causing some other
action to occur after a synchronization, including the execution of an
AppleScript.

The file which is opened can be any file on your Mac, including another
synchronization setup document, any alias or an AppleScript saved as an
application. This allows another synchronization to be started or an AppleScript
to be executed when a synchronization is complete.

Conflicts…

Use the Conflicts… option to set the handling of file conflicts. Conflicts settings
do not apply to backups.

There are two types of file conflicts:

• Editing Conflict . Both files have been changed since the last synchronization.
Overwriting the older file in this situation causes the changes made to it to be
lost.

An editing conflict is noted with this symbol: 



Synchronize! Pro X Reference 50

• Name Conflict . Two files have the same name, but have different types. An
example of such a situation might be two files called “Proposal”, one of which
was created by a word processing application, and another which was created by
a spreadsheet application. The two files are obviously different, and should not
overwrite each other.

A name conflict is noted with this symbol: 

Conflicts… settings

Don't check for conflicts

Check this box to turn off conflict checking. When this box is checked, less disk
space and less memory is required. Synchronization will also take less time.

Alert Me

When this box is checked, a conflict will be announced with a dialog box.

Donʼt copy either file

Click this button to avoid copying conflicting files.
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Overwrite the older file

Click this button to overwrite the older file. This is the same action taken when
conflict checking is turned off.

Move the older file to the Conflicts Folder

Click this button to move the older conflicting file to a special Conflicts Folder.
This folder is located immediately within the top-level folder containing the
conflicting file. If a Conflicts Folder does not exist, it will be created.

After the conflicting file is moved, the newer version of the file will be copied to
replace it.
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Copy only files…

Copy only files… settings

“Copy only files” restricts the files which are copied. Only files which meet the
criteria will be copied. Other files which do not meet the criteria are ignored by
Synchronize! Pro X.

If no boxes are checked in this dialog, all files in all folders are copied.
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“Whose names” check box

Use this check box to copy files by matching their names. Click “Add…” to add
an entry to the list. Double-click an entry to make changes. Click “Remove” to
remove an entry from the list. Matches can be made with the first part of the
name (starts with), the last part of the name (ends with), the whole name
(matches), or a part of the name (contains).

Multiple partial names may be entered. When multiple entries are in the list, any
one entry that matches will cause the file to be included in the set of matching file
names.

“Which are in the list” check box

Use this check box to copy files by matching their name and specific location.
Click “Add…” to add an entry to the list. Click “Change…” or double-click an
entry to change it. Click “Remove” to remove an entry from the list.

To see the path of a particular file, hold the mouse over the file name for more
than two seconds.

 “Which were modified” check box

This check box restricts files by how old they are, or by the time they were last
changed. Use this check box to copy files which are older, or newer by a certain
time, or some particular date.

 “Which are applications” check box

Use this check box to copy only those files which are applications, like
Synchronize! Pro X, a word processor, or a spreadsheet. Documents are not
copied if this is the only box checked.

“Which are aliases” check box

Use this check box to copy only those files which are aliases. This check box has
no effect when the “Resolve Aliases” option is checked, because the alias is
resolved first.

“Which are invisible” check box

Use this check box to copy only those files which are invisible. The invisible files
for virtual memory, and the Desktop files, are never copied, even when this box
is checked.

“Which are icon files” check box

Use this check box to copy only those files that are icon files. An icon file is the
invisible file inside a folder that contains the icon for a folder. This check box is
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primarily useful to avoid copying icon files to servers which don’t support
certain characters in file names. The name of an icon file is “Icon\r”, which will
generate an error from some Windows file servers.

 “Which have type and/or creator” check box

This check box restricts files to documents that have particular types and/or
creators. The most common types are TEXT and PICT, which refer to files
containing text only and bitmap pictures, respectively. Use this check box to copy
only certain kinds of files.

A file’s creator is usually the application that saved the file. Set the creator for
files saved by a particular application.

“Which are labelled” check box

This check box restricts files to documents that have a certain label. If a file on
either side of the backup or sync has a label which matches, the file will match.

Don't copy any files…

Choose “Don't copy any files…” to choose files which are not to be copied. A
dialog box is presented which is identical to the “Copy only files…” dialog box
described above. This dialog box, however, describes files which will      not     be
copied.

Well, you ask, what happens if I tell it to copy a file, and also tell it not to copy a
file? It won’t be copied.

Synchronize! Pro X first includes all files which meet the criteria in the “Copy
only files” dialog, then excludes those which meet the criteria in the “Don't copy
files” dialog.

If no boxes are checked in this dialog, no files are ignored.
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Copy only folders…

Use “Copy only folders…” to limit a synchronization to a subset of folders.

This option is useful for synchronizing only certain folders on a hard disk.
Criteria for folders include full or partial folder name, inclusion in a list, and
whether the folder is invisible.

Copy only folders… settings

“Whose names” check box

Use this check box to copy the contents of folders by matching all or part of their
names. Enter the portion of the name to be matched. Use the popup menu to
choose the kind of matching. Matches can be made with the first part of the name
(starts with), the last part of the name (ends with), the whole name (matches), a
part of the name (contains), or from a list of file names (are in the list).
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“Which are in the list” check box

Use this check box to copy the contents of specific folders. Click Add… to add a
folder to the list. Click Add Name to add a folder by name without having to
find it on disk.

To remove a folder from the list, click the folder and click the Remove button.

Any number of folders may be included in the list. Only those folders that
actually reside within the top-level folders shown in the sync setup will be
copied.

To see the path of a particular folder, hold the mouse over the folder for more
than two seconds.

Donʼt copy folders…

Use “Don’t copy folders…” to exclude certain folders from a synchronization.

This option is useful for synchronizing several folders on a hard disk without
synchronizing them all. For example, you might want to synchronize all folders
on your disk except the System folder and the Applications folder.

Use this option to identify folders whose contents are not to be synchronized, in
a manner similar to that shown in “Copy only folders…” above.
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Fast scan

This option enables a faster method of finding files that need to be copied. It is
particularly useful for large sets of files, because this method does not require
individually examining every file and folder in the set.

An example of a great use for this is to speed up a Bootable System Backup.
While running a Bootable System Backup the first time can’t take advantage of
this feature, updating the backup (which is done by running a “Bootable System
Backup” again) will be much faster when Fast scan is used.

Fast scan… settings
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Enable fast scan

Check this box to enable fast scan of folders. When this box is checked, several
criteria are used to determine whether a fast scan is allowed. A full folder scan
must have been performed previously, and the disk must be mounted locally,
not remotely over a network.

Fast scan is available on on Mac OS X 10.5 or later.

If you think files in either folder may have been modified on a system that is not
running Mac OS X 10.5 or later, you should disable fast scan and run a backup or
synchronization, to ensure that all files in both folders are the same.

Check backup disk for changes

Check this box if there is a possibility that changes may occur to the backup disk.
When this box is not checked, the assumption is made that the backup disk is not
changed by any application. This box is normally not checked for a backup.

Checking this box will cause more folders to be scanned, so if you know that the
backup disk isn’t being modified, it is faster to leave it unchecked.
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Comparing files

This option provides alternatives to the default method of comparing files for
synchronization or backup.

Comparing files… settings

Copy files if modification time is different

This is the normal setting. This setting compares the time that a file was modified
and copies all files which have different modification times.

Copy files if modification time is not an exact multiple of one hour

Use this setting to synchronize or backup files whose modification dates may
have been changed due to a change in Daylight Savings Time or time zone.

Copy files if modification time difference is > 5 seconds

Use this setting to cause files whose modification times are different by a certain
number of seconds to be considered the same.

Normally, files whose modification times are different at all are copied by
Synchronize! Pro X. This works well for file servers which store and report
modification times in seconds.
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Some file servers, however, either do not store file modification times to the
second, or do not report the modification time precisely. This option allows the
flexibility needed for these circumstances.

If files which were just copied are subsequently reported to be different, show
the files to be copied and click on a pair of files in the Files To Copy window. The
time difference between the files is shown in at the bottom of the window. Set the
number of seconds for this option to be a little greater than the maximum
difference observed.

One instance in which this option is needed is when connecting to some
Windows file servers which store the file modification date to the nearest two
seconds. In this instance, the number of seconds should be 1.

Copy files if file size is different

Check this box to backup files whose modification dates may be the same, but
the file size is different. This option is only valid for a backup, when a Master box
is checked.

Copy files if 'ckid' resource is different

Check this box to backup files which are managed with the 'ckid' resource. This
setting is usually used for backing up source code managed by such as Projector
and VOODOO. This option is only valid for a backup, when a Master box is
checked

Copy files if creator or type is different

Check this box to backup files whose modification dates may be the same, but
the file size is different. This option is only valid for a backup, when a Master box
is checked.

Adjust file times

Check this box to adjust file times on one or both disks.

This option corrects a potentially difficult situation which arises from
synchronizing two disks which were witten with the same files but with a
different time zone setting.

Change file times

This option allows the modification times of files on one or both disks to be
changed by a number of hours. This is useful primarily for synchronizing or
backing up a MacOS Standard Format disk that was written by a computer in a
different time zone.
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Use this button to show the following settings:

Change file times settings

The values entered are used to adjust the times of all files in the folders shown.
This adjustment is handled internally by Synchronize! Pro X – it does not affect
the actual creation and modification times stored on the disk.

When files are moved to another folder on the same disk, they are moved very
quickly. When files are moved to another disk, they are copied completely, then
the original file is deleted.

Run as ʻrootʼ

Check “Run sync with root privileges” to sync or back up files with root
privileges. This is needed when copying files to which the logged-in user does
not normally have access. If you are copying files between two directly-
connected hard disks, and you are getting permission errors, it is probably
appropriate to check this box.

This option is not available when the source or the destination is on a remote
disk.
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Skip files

Check “Skip files which can’t be copied due to insufficient privileges” to copy
only those files which should not cause permission errors. This may be useful
when a few files can’t be accessed due to their permissions.

Warning: using this feature may mask a problem that should be solved, rather
than hidden. Usually, it is better to identify permission problems and correct
them, or exclude certain files from a backup or sync, rather than use this feature,
because the files that are skipped may be ones you wanted backed up.

Copy existing files only

Check “Copy existing files only” to synchronize only those files which have an
existing corresponding file in the other folder. Any file which does not have a
corresponding file already in existence will be ignored.

This option is not active when a Master box is checked.

Donʼt copy empty folders

When “Don’t copy empty folders” is checked, any folders which would normally
be created, and which will be empty when the synchronization is completed, will
not be copied.

This option is useful when copying or moving only certain files. With this option
checked, only those folders which will contain files will be created.

Donʼt delete folders

Check “Don’t delete folders” to avoid deleting any folders during a sync or
backup. This is useful, for example, when a backup is set to “Copy only files that
end with ‘.txt’”. If the Setup Type is Backup, and the source folder is empty, and
“Don’t delete folders” is checked, then all files that end in “.txt” that are in the
destination folder will be deleted, and all folders in the destination will be left as
they are.

Sync deleted files

When “Sync deleted files” is checked, any files which are deleted from one folder
will cause the corresponding file to be deleted at the next synchronization.

Check this option to make it easier to delete files from two synchronized folders;
when this option is not checked, a file which is deleted from one folder, or
dragged to the Trash, will be replaced by a copy of the file from the other folder.

With this option checked, when a file is no longer needed, just drag it to the
Trash. Its corresponding file will be deleted during the next synchronization.
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This option is not available if “Don’t check for conflicts” is checked in the
“Conflicts…” settings.

Copy locked state

Use this option to copy the locked state of every file to the destination. When this
option is checked, any file which is locked in the master folder will also be locked
in the destination folder, and any file which is not locked in the master folder
will  not be locked in the destination folder. The contents of files whose locked
state is different are copied only if the files have different modification dates.

This option is available only for backups. In a backup, files can be copied in only
one direction.

PC Compatibility

This option provides a method of eliminating copying of resource forks to a PC-
formatted disk. Resource forks appear on a PC as files whose names start with
“._” (dot-underscore).

PC Compatibility settings

Donʼt copy resource forks

Check this box to prevent resource forks from being copied. PLEASE NOTE that
some files have essential data in their resource forks, and not copying this data
may cause the files to be corrupt. In general, a good rule of thumb is that if the
file is created on a PC, and it can be correctly read on a Mac, you can copy the file
without the resource fork without a problem.

Donʼt copy files that have a resource fork

Use this setting to ignore files in your sync or backup that have a resource fork.
When this box is checked, files that have a resource fork won’t be copied.
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Donʼt replace files that have a resource fork

Use this setting to ignore files in your sync or backup that have a resource fork.
When this box is checked, files that have a resource fork won’t be copied.
WARNING: Replacing a file that has a resource fork with one that doesn’t could
damage the file so that it cannot be used, if that file needs a resource fork. Some
do, and some don’t.

If you’re unsure about whether to uncheck “Don’t copy files that have a resource
fork” or “Don’t replace files that have a resource fork”, you probably shouldn’t.
Unchecking both boxes will corrupt any files that must retain their resource
forks.
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Permissions

This option provides flexibility in copying and setting file and folder
permissions.

Permissions… settings

Permissions allow different users and groups “read-write-execute” privileges for
a file or folder. These users and groups are called “Owner”, “Group”, and
“Everyone”. If you’re not familiar with these terms, don’t worry, you probably
don’t need to use this option, and you should leave it with its “normal” settings,
as shown above.
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Keep in mind that the owner and group of a file or folder is copied only when
Synchronize! Pro X is performing an operation with root privileges.

Donʼt set permissions of copied files and folders

Check this box to use whatever default permissions will be assigned to files and
folders copied to another volume. This is useful when the destination doesn’t
support OS X-style permissions, and errors result when checking that they were
set correctly. Some examples of such volumes are remotely-mounted Windows
volumes and Mac OS 9 disks connected using File Sharing.

Using the permissions options

These options allow flexibility in setting the permissions of copied files and
folders.

For example, if you want everyone to have “Read & Write” access for all copied
files:

1. Click Set permissions of copied files to.
2. Set the popup menus for Owner, Group and Everyone to “Read &

Write”.
3. Click OK.

Normally, permissions are set only for files whose contents are copied. To ensure
that all files in the destination folder to have the same permissions, check Copy
permissions to all destination files. This will cause all files to have their
permissions set, even if their contents do not need to be copied.

To force all files in the destination folder to have the permissions of the
corresponding files in the source folder, make these settings:

1. Check Copy permissions to all destination files.
2. Click Copy file permissions exactly.
3. Click OK.

Folders have permissions, too. The settings for folders work the same way.

Copy permissions to all destination files

Check this box to copy permissions from the source files to the corresponding
destination files, even if the contents of the files have not been modified, and the
file contents won’t be copied. This option is available only for backups.

Copy file permissions exactly

Make this active to copy permissions from the source file to the destination file.
This is done for both synchronization and backup.
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Set permissions of copied files to

Make this active to force a set of permissions to be associated with copied files,
regardless of the permissions associated with the source file.

Permissions popup menus

Use the Owner, Group and Everyone popup menus to set specific permissions
to be used for copied files.

Copy execute bit

Make this active to copy the execute bit for copied files. This is the normal
setting.

Clear execute bit

Make this active to clear the execute bit for copied files. If you’re not familiar
with the execute bit, make “Copy execute bit” active.

Copy permissions to all destination folders

Check this box to copy permissions from all source folders to the corresponding
destination folders, even if the folders don’t need to be copied. This option is
available only for backups.

Copy folder permissions exactly

Make this active to copy permissions from any copied source folder to the
destination folder. This is done for both synchronization and backup.

Set permissions of copied folders to

Make this active to force a set of permissions to be associated with copied folders,
regardless of the permissions associated with the source folder.

Permissions popup menus

Use the Owner, Group and Everyone popup menus to set specific permissions
to be used for copied folders.

Copy owner and group

Check this box to copy owner and group information for files and folders. This
box is automatically checked for Bootable System Backups. Normally, owner and
group information cannot be copied unless the backup or sync is performed with
root privileges (that is, the “Run as root” option is checked in the Options menu).
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Extended attributes

Use this option to control whether and how Extended Attributes are copied.
Extended Attributes are small bits of information that can be attached to a file
without modifying the actual contents of the files. For example, on some versions
of OS X, the time, date, and URL of a downloaded application are saved as an
extended attribute attached to that application.

Extended Attributes are available on Mac OS X 10.4 and later.

This option has no effect when used on a disk that doesn’t support extended
attributes.

Extended Attributes settings
Using the setting “Copy extended attributes when different” will cause the folder
scan to be slower, because the extended attributes for all files must be read
during the scan. However, this setting has the advantage of copying extended
attributes when the only thing that was changed is the extended attributes.

By contrast, “Copy extended attributes only when file data is copied” is faster,
because the extended attributes are read only for those files that are copied.
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Copy ACLs

Use this option to control how ACLs (Access Control Lists) are copied. ACLs are
available on OS X 10.4 Server and Mac OS X 10.5 and later. This option has no
effect when used on a disk that doesn’t support ACLs.

Copy ACLs settings
Using the setting “Copy Access Control Lists when different” will cause the
folder scan to be slower, because the ACL for all files must be read during the
scan. However, this setting has the advantage of copying ACLs when the only
thing that was changed is the ACL.

By contrast, “Copy Access Control Lists only when file data is copied” is faster,
because the ACL is read only for those files that are copied.

Move files

Use “Move files” to move files, rather than copy them. Use this feature to extract
certain files from a larger set. For example, all word processing documents last
modified more than two months ago could be moved to a floppy disk for
storage.
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Verify files…

Using this feature, files can be verified either after a backup or sync, or
independently.

To verify files after a backup or sync, use the Options menu to choose “Verify
files…”. To verify files independently, use the “Setup type” popup menu to
choose “Verify”, and set the options for the verify operation using “Verify
files…” in the Options menu.

Verify files… settings
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Verify copied files and folders

Make this active to verify only files and folders that are copied during a
particular backup.

Verify all files and folders

Make this active to verify all files and folders contained in the selected source
and destination folders. When this setting is active, all files and folders are
verified after every sync or backup, whether they were copied as a part of that
sync or backup or not.

Compare all attributes

Make this active to compare all attributes for files and folders. This is the default
setting.

Compare selected attributes

Make this active to compare only certain attributes of the files and folders.

Compare owner and group

Check this box to compare owner and group information. This information is
checked for folders and files.

Compare permissions

Check this box to compare permissions of both folders and files. “Permissions”
are Read & Write, Read Only, Write Only, and No Access, for owner, group, and
everyone.

Compare file creator and type

Check this box to compare the creator and type of files. For files which have no
creator and type, a comparison may cause the false generation of an error.

Compare file dates

Check this box to compare the creation and modification times of files.

Compare file data

Check this box to compare the contents of the files. Only certain forks or all forks
(yes, there can be more than two) may be compared.
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Log the first 32 bytes that are different

Check this box to log a portion of any files whose data does not match. The file
data is logged in hexadecimal and, where possible, ASCII.

Log all differences for each item

Make this active to log any number of differences found in a file or folder.

Log the first difference and skip further tests

Make this active to log only the first difference found in a file or folder. When
this is active and a mismatch is found, other attributes of the file or folder are not
checked.

Verify everything regardless of compare results

Make this active to verify all files and folders, even if one or more mismatches
occur.

Stop verifying after the first mismatch

Make this active to stop the verification after the first mismatch.
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Archive files…

This feature keeps a copy of replaced and deleted files in an archive, so that an
old version of a file, or a deleted file, can be recovered.

This is an optional feature which must be enabled to be active. To enable this
feature, choose a folder to be the archive folder. This folder can be on the same
disk as the backup, or it can be in another location.

Archive files… settings
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Files are saved to the archive for a particular destination. For a backup, there is
one archive. For a synchronization, there are two archives – one for files replaced
or deleted in the left-hand folder, and a separate archive for files replaced and
deleted in the right-hand folder.

Archive folder organization

Archived files are saved in the same folder hierarchy used for the original
backup. This means that any number of files that have the same name but are in
different folders will be archived if they are replaced or deleted during a backup
or synchronization.

Files are optionally grouped into chunks of a specified size. This is useful, for
example, to keep archived files in chunks that can be conveniently copied to a
CD-R. Once a group of archived files is copied to the CD-R, it can be deleted,
freeing space for more archived files.

Inside the archive folder, the group folder called “Current Group” always
contains the most recently archived files. When the size of the folder “Current
Group” reaches the maximum allowed size, it is given the name corresponding
to the most recent archive operation.

Inside a group folder, a folder will exist for each sync or backup operation that
archived one or more files. This folder will have a name which starts with a
sequence of numbers, followed by the date and time of the sync or backup.

Don’t change the name of the folders inside the group folder. If their names are
changed, the archive can’t be purged of its oldest files.

Finding previous versions of a file

The easiest way to find all the versions of a particular file is to use the “Find”
function in the Finder. Here’s how:

1. In the Finder, navigate to the archive folder.
2. Use the File menu to choose “Find…”.
3. Use the popup menu to choose “Specific places”.
4. Uncheck all items in the list.
5. Drag and drop the icon for the archive folder on the list below the “Specific

places” popup.
6. Set the criteria for the search (for example, “file name contains”).
7. Click the Search button.
8. Files matching the criteria will be shown in a “Search Results” window. Click

on the particular file to see its location. Double-click the folder containing the
file to open a Finder window containing that file.
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Archive replaced and deleted files

Check this box to enable saving archive files. Choose the folder that will be the
destination for the archive.

Preserve free space

Check this box to keep a certain amount of space free on the disk containing the
archive. The oldest files in the archive will be deleted to keep the required
amount of space available on the disk.

Group archive folders

Check this box to group files in the archive in chunks of a particular size. Enter
the size of the groups (650 MB, for example, to make it easy to save group folders
to CD-R) in the box.

It’s OK to manually delete any and all group folders inside the archive folder.
You may want to delete a group folder after you’ve copied it to a permanent
backup medium like CD-R.

Archive only certain files…

Check this box to limit the files that are archived. Click the Choose button to set
the criteria.

Donʼt archive certain files…

Check this box to limit the files that are archived. Click the Choose button to set
the criteria. Files which meet the “Archive only certain files” criteria and also
meet the “Don’t archive certain files” criteria will not be archived.

Archive files only in certain folders…

Check this box to limit the folders whose files are archived. Click the Choose
button to set the criteria.

Donʼt archive files in certain folders…

Check this box to limit the files that are archived. Click the Choose button to set
the criteria. Files which meet the “Archive files only in certain folders” criteria
and also meet the “Don’t archive files in certain folders” criteria will not be
archived.

Remove archived files from backups

Check this box to automatically remove old archived files. Files archived more
than the specified number of days in the past are removed each time the backup
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or sync is performed. The “Don’t remove files from backups” setting takes
precedence over this setting.

Donʼt remove files from backups

Check this box to prevent recently-archived files from being automatically
removed from the archive. If there is no space for new files to be copied to the
disk containing the archive, the oldest files are removed from the archive. Setting
this option prevents the removal of files archived from newer backups. This
setting takes precedence over “Remove archived files from backups”.

Multiple Items

 “Multiple Items” is used to include files and folders from different parts of a
disk, or different disks, in a synchronization.

Any number of item pairs may be included.

Multiple Items settings

Add

Click this button to add an item pair.

Remove

Click this button to remove the selected item pair(s). At least one item pair must
be in the list for “Multiple Items” to be active.
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Choosing items in a pair

Click the item icon to choose the particular item to be synced. Two files or two
folders can be included in an item pair. When files are included in an item pair,
the names of the files must be the same.

To choose invisible files or folders, hold down the Option key when you click the
icon for the item.

Seeing the path of an item

To see the location of an item, hold down the Command key and click the icon
for the item.

Changing the order of item pairs

To move an item pair up or down in the list, click an item to select it and type
command-up-arrow or command-down-arrow.  The command key also has an
apple outline on it.

Resolve aliases

When “Resolve aliases” is enabled, aliases may be used to include files and
folders in a synchronization, even if they actually reside elsewhere.

An alias is a file which contains information on the location of a file or folder. Its
contents “point” to the actual location of the file or folder. An alias is useful
because, in many cases, it can be used as the actual file or folder, while allowing
the actual file or folder to be located elsewhere.

To use an alias to include a file or folder in a synchronization, create an alias to
the file or folder in the Finder with Make Alias in the File menu. Drag the alias to
the folder to be synchronized. Check Resolve aliases in the Options menu in your
Synchronize! Pro X document.

When the folder is synchronized, the alias is “resolved”, which causes the alias to
be replaced with the file or folder itself, as if it were actually located where the
alias is located.

Note: Changes were made to the way that aliases work starting with Panther
(Mac OS X 10.3),  and as a result, aliases may not work as you expect. To
avoid potential problems, we recommend that you use the “Multiple
Items” feature rather than “Resolve aliases”.
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Resolve aliases settings

Donʼt resolve aliases

Click this button to copy aliases as ordinary files.

Resolve top-level aliases only

Click this button to resolve only those aliases which are immediately within the
folder which appears in the setup document. Any alias in a folder which is
nested inside the top-level folder will not be resolved.

Note: Remember that the name of the original file is used to find a
corresponding file, not the name of the alias. It’s a good idea to give the
alias a name similar to the name of the original it was created from, but
it’s not necessary.



Synchronize! Pro X Reference 79

Monitoring

Use this option to monitor backups or synchronizations, and to receive email
when the backup or synchronization occurs, has errors, is missed, or doesn’t
complete.

Monitoring settings
Check “Report backup status” to enable monitoring of this backup or
synchronization.

When this box is checked, Synchronize! Pro X will report its status to the Qdea
Backup Monitor, a specially-configured web server. The Qdea Backup Monitor
watches for the backup to occur, and sends emails based on settings you make.

Using this feature requires setting up an account on the Qdea Backup Monitor.
Once you have an account, you can configure which notifications you want to
receive via email.

Once you have an account on the Qdea Backup Monitor, you can look at the
status of your monitored backups using any web browser. You can see the recent
history of backups, whether there were any errors, and you can examine the Log
contents for recent backups.



Synchronize! Pro X Reference 80

Enter a description of the purpose of the backup in Backup Description . This
information will be visible when you look at the backup in the Qdea Backup
Monitor.

Windows menu

The Windows menu shows all open windows. When you open sync setup
documents, they are added to the Windows menu.

Use the Windows menu to show a particular window. Notice that the Waiting
List, Status, Auto Syncs and Log windows are always present in the Windows
menu. These windows are always available, although they may not be visible.

For more information about the Waiting List, Status, Log and Help windows, see
the section “Synchronize! Pro X Windows”, above.

The Windows menu is particularly useful when many Synchronize! Pro X setup
documents are open at the same time. Use it to show the window for a particular
setup document.

The check mark in the Windows menu shows which window is active. If no
windows are active, no check mark will appear in the menu.
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Requirements
Synchronize! Pro X is designed to work effectively on all Macintosh computers
running Mac OS X 10.3 or later.

Synchronize! Pro X supports AppleScript. For more information on AppleScript
support, see the Tips and Techniques section in this manual.

Synchronize! Pro X documents vary in their requirements for disk space. When
large disks are synchronized with conflict checking turned on, disk space
requirements can be substantial.
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Feedback
Synchronize! Pro X can be what you’d like it to be. Make
suggestions and see them incorporated into the product.

Send us your suggestions and feedback via electronic or regular
mail to:

Email
support@qdea.com

U.S. Mail
Qdea
Technical Support
2501 Skyblue Court
St. Paul,  MN  55110  USA

Technical Support
Technical Support is available for Synchronize! Pro X via email,
or by letter at the address above. Please allow 48 hours for a
response to email.

Email support@qdea.com

Technical support is also available by telephone:
+1 (651) 779-0640

Answers to common questions about Synchronize! Pro X are
posted on the Qdea web site:

http://www.qdea.com

Upgrades
New versions of Synchronize! Pro X are published periodically
on the Qdea web site.

For the latest version, check Qdea’s Web site:
http://www.qdea.com

The latest version is available by visiting this direct URL:
http://www.qdea.com/pages/downloads1.html
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Index

A
Add button – Multiple Items, 76
Alert Me, 50
Archive files only in certain folders, 75
Archive folder organization, 74
Archive only certain files, 75
Archive replaced and deleted files, 75
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Auto-Connect, 41, 42
Auto-Connect dialog box, 43
Automatically connect, 43
AutoSync, 47
AutoSync Preferences, 37
AutoSyncs window, 26

B
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C
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Changing the order of item pairs, 77
Choosing folders, 18
Choosing items in a pair, 77
Clear, 41
Clear execute bit, 67
Close, 40
Close this document, 48
Compare all attributes, 71
Compare file creator and type, 71
Compare file data, 71
Compare file dates, 71
Compare owner and group, 71
Compare permissions, 71
Compare selected attributes, 71
Comparing files, 59
Comparing files settings, 59
Completion Options, 48
Conflicts, 49
Continue button, 25
Copy, 41
Copy ACLs, 69
Copy ACLs settings, 69
Copy Direction Arrow, 19
Copy execute bit, 67
Copy existing files only, 62
Copy file permissions exactly, 66
Copy folder permissions exactly, 67
Copy locked state, 63
Copy only files…, 52
Copy only folders…, 55
Copy owner and group, 67
Copy permissions to all destination files, 66
Copy permissions to all destination folders, 67
Cut, 41
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D
DefaultsPreferences, 30
Delete files and folders not in the master folder, 20
Disk Errors Preferences, 35
Document windows, 18
Don’t add AutoSync to the login list, 38
Don’t archive certain files, 75
Don’t archive files in certain folders, 75
Don’t copy either file, 50
Don’t copy empty folders, 62
Don’t copy folders…, 56
Don’t install AutoSync automatically, 38
Don’t open Untitled window at startup, 28
Don’t remove files from backups, 76
Don’t resolve aliases, 78
Don’t save anything in the log, 40
Don’t set permissions of copied files and folders, 66
Don’t show ‘no files to copy’ dialog, 29
Don't check for conflicts, 50
Don't copy any files…, 54
Don't Start button, 47
Down button, 26

E
Edit menu, 41
Eject disk, 49
Extended attributes, 68
Extended attributes settings, 68

F
Fast scan, 57
Fast scan settings, 57
Feedback, 82
File Change Preferences, 34
File Conflicts, 49
File Errors Preferences, 36
File menu, 40
Files To Copy Preferences, 33
Files to copy window, 21
Finding previous versions of a file, 74
Folder icon, 18
Force unmount, 49

G
General Preferences, 28
Group archive folders, 75

H
Hide after launch, 38
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I
Include file path, 40
Install AutoSync, 38
Installation, 4
invisible files, 53

L
Log all differences for each item, 72
Log bytes that are different, 72
Log file size, 39
Log Preferences, 39
Log the first difference, 72
Log the names of copied files, 40
Log window, 27
Log Window Font, 39
Log Window Size, 39

M
Master check box, 19
Monitoring, 79
Monitoring Preferences, 32
Monitoring settings, 79
Move files, 69
Move the older file to the Conflicts Folder, 51
Multiple Items, 76

N
New, 40

O
Open, 40
Open button, 27
Open in the background, 38
Open the file, 49
Options menu, 41
Overwrite the older file, 51

P
Paste, 41
Pause button, 25
PC Compatibility, 63
PC Compatibility settings, 63
Permissions, 65
Permissions popup menu, 67
Permissions popup menus, 67
Preferences, 28
Preserve free space, 75
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Q
Quit, 41, 49

R
Remove archived files from backups, 75
Remove button, 27
Remove button – Multiple Items, 76
Remove from list, 23
Remove from list button, 26
Reopen at startup, 20
Requirements, 81
Resolve aliases, 73, 77
Resolve top-level aliases only, 78
Retry, 36
Retry button, 43
Retry dialog box, 44
Reversing copying direction, 23
Revert, 41
Run as ‘root’, 61

S
Save, 40
Save As, 41
Seeing the path of an item, 77
Set permissions of copied folders, 67
Set privileges of permissions files, 67
Setup type popup, 19
Show files to copy, 20
Show Log window at startup, 39
Skip, 36
Skip files, 62
Skip immediately and log the error, 36
Start, 24
Start again every…, 47
Start only on certain days, 47
Start Options, 45
Start Options dialog box, 45
Start synchronization at a preset time, 47
Start synchronization at login, 45
Start synchronization before Quit, 46
Start synchronization when disks become available, 46
Start synchronization when document is opened, 46
Start synchronization when folder changes, 46
Status window, 24
Stop button, 24
Stop verifying after the first mismatch, 72
Sync deleted files, 62
Sync… button, 21
Synchronize! Pro X menu, 28
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T
Technical Support, 82
Triangle icons, 49

U
Undo, 41
Unmount disk, 49
Up button, 26
Upgrades, 82

V
Verify all files and folders, 71
Verify copied files and folders, 71
Verify everything regardless of compare results, 72
Verify files, 70

W
Wait forever, 36
Waiting List window, 25
Wake up computer A, 42
Wake up computer B, 42
Wake up settings dialog box, 42
Warnings Preferences, 31
When copying is complete, play, 29
When copying is complete:, 48
Windows menu, 80
Windows, description of, 18


